Chapter 3
Geometric Construction and Editing Tools

Learning Objectives

- Set up the display of Drawing Units
- Display AutoCAD’s toolbars
- Set up and use OBJECT SNAPS
- Edit, using EXTEND and TRIM
- Use the FILLET command
- Create parallel geometric entities
- Using the PEDIT command
- Use the EXPLODE command
AutoCAD Certified User Examination Objectives Coverage

This table shows the pages on which the objectives of the Certified User Examination are covered in Chapter 3.

### Section 1: Introduction to AutoCAD

- Point Style .................................................. 3-16
- Ortho Mode .................................................. 3-25
- Precision ..................................................... 3-25
- Drafting Settings ............................................ 3-26
- Snap and Grid ................................................ 3-26

### Section 2: Creating Basic Drawings

- Start from Scratch .......................................... 3-5
- Geometric Construction .................................... 3-6
- Bisection of a Line or Arc .................................. 3-6
- Snap to Perpendicular ...................................... 3-6
- Snap to Midpoint ............................................ 3-6
- Bisection of an Angle ....................................... 3-9
- Construction Line ........................................... 3-9
- Snap to Node .................................................. 3-16
- Circle through Three Points ............................... 3-17
- 3-Point Circle ................................................ 3-17
- Line Tangent to a circle from a Given Point ........... 3-18
- Circle of a Given Radius Tangent to Two Lines ....... 3-21
- Fillet command ............................................... 3-20

### Section 3: Manipulating Objects

- Move command ............................................... 3-7
- Rotate command ............................................. 3-11
- Transfer of an Angle ....................................... 3-11
- Copy command .............................................. 3-11
- Dividing a Given Line into Equal Parts ................ 3-15
- Point, Divide ................................................ 3-16
- Extend command ............................................. 3-30

### Section 4: Drawing Organization and Inquiry Commands

- QuickCalc command ........................................ 3-12
- Angle of Line Defined by Two Points ..................... 3-13
- Measure Area and Perimeter ............................... 3-36

### Section 5: Altering Objects

- Offset command ............................................. 3-34
- Edit Polyline ............................................... 3-34
- Explode ....................................................... 3-38

### Section 11: Creating Additional Drawing Objects

- Polylines ..................................................... 3-34
**Tips on Taking the AutoCAD Certified User Examination**

1. **Study**: The first step to maximize your potential on an exam is to sufficiently prepare for it. You need to be familiar with the AutoCAD package, and this can only be achieved by doing drawings and explore the different commands available. The AutoCAD Certified User exam is designed to measure your familiarity with the AutoCAD software. You must be able to perform the given task and answering the exam questions correctly and quickly.

2. **Make Notes**: Take notes of what you learn either while attending classroom sessions or going through study material. Use these notes as a review guide before taking the actual test.

3. **Time Management**: Manage the time you spent on each question. Always remember you do not need to score 100% to pass the exam. Also keep in mind that some questions are weighed more heavily and may take more time to answer.

4. **Be Cautious**: Devote some time to ponder and think of the correct answer. Ensure that you interpret all the options correctly before selecting from available choices.

5. **Use Common Sense**: If you are unable to get the correct answer and unable to eliminate all distracters, then you need to select the best answer from the remaining selections. This may be a task of selecting the best answer from amongst several correct answers, or it may be selecting the least incorrect answer from amongst several poor answers.

6. **Take Your Time**: The examination has a time limit. If you encounter a question you cannot answer in a reasonable amount of time, use the Save As feature to save a copy of the data file, and mark the question for review. When you review the question, open your copy of the data file and complete the performance task. After you verify that you have entered the answer correctly, unmark the question so it no longer appears as marked for review.

7. **Don’t Act in Haste**: Don’t go into panic mode while taking a test. Always read the question carefully before you look out for choices in hand. Use the Review screen to ensure you have reviewed all the questions you may have marked for review. When you are confident that you have answered all questions, end the examination to submit your answers for scoring. You will receive a score report once you have submitted your answers.

8. **Relax before exam**: In order to avoid last minute stress, make sure that you arrive 10 to 15 minutes early and relax before taking the exam.
Geometric Constructions

The creation of designs usually involves the manipulations of geometric shapes. Traditionally, manual graphical construction used simple hand tools like a T-square, straightedge, scales, triangles, compass, dividers, pencils, and paper. The manual drafting tools are designed specifically to assist in the construction of geometric shapes. For example, the T-square and drafting machine can be used to construct parallel and perpendicular lines very easily and quickly. Today, modern CAD systems provide designers much better control and accuracy in the construction of geometric shapes.

In technical drawings, many of the geometric shapes are constructed with specific geometric properties, such as perpendicularity, parallelism and tangency. For example, in the drawing below, quite a few implied geometric properties are present.
Starting Up AutoCAD 2015

1. Select the AutoCAD 2015 option on the Program menu or select the AutoCAD 2015 icon on the Desktop. Once the program is loaded into the memory, the AutoCAD 2015 drawing screen will appear on the screen.

2. In the Startup window, select Start from Scratch, as shown in the figure below.

3. In the Default Settings section, pick Imperial (feet and inches) as the drawing units.

4. Pick OK in the Startup dialog box to accept the selected settings.
**Geometric Construction – CAD Method**

The main characteristic of any CAD system is its ability to create and modify 2D/3D geometric entities quickly and accurately. Most CAD systems provide a variety of object construction and editing tools to relieve the designer of the tedious drudgery of this task, so that the designer can concentrate more on design content. A good understanding of the computer geometric construction techniques will enable the CAD users to fully utilize the capability of the CAD systems.

- Note that with CAD systems, besides following the classic geometric construction methods, quite a few options are also feasible.

**• Bisection of a Line or Arc**

1. Create an arbitrary arc AB at any angle, and create line AB by connecting the two endpoints of the arc.

2. Switch **ON** only the Dynamic Input option by clicking on the buttons in the Status Bar area as shown.

3. Select the Line command icon in the Draw toolbar. In the command prompt area, near the bottom of the AutoCAD drawing screen, the message “_line Specify first point:” is displayed. AutoCAD expects us to identify the starting location of a straight line.

4. Pick **Snap to Perpendicular** in the Object Snap toolbar. In the command prompt area, the message “_per to” is displayed.
5. Select line AB at any position.
   - Note the tooltip *Deferred Perpendicular* is displayed indicating the construction is deferred until all inputs are completed.

6. Select an arbitrary point above the line as shown.

7. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter with the left-mouse-button to end the Line command.

8. Select Move in the Modify toolbar as shown.

9. Select the perpendicular line we just created.
   - In the command prompt area, the message: "Specify the base point or [Displacement]" is displayed. AutoCAD expects us to select a reference point as the base point for moving the selected object.
10. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

11. Select the lower **Endpoint** of the selected line as shown.

12. Move the cursor inside the Drawing Area, and notice the line is moved to the new cursor location on the screen.

13. Pick **Snap to Midpoint** in the *Object Snap* toolbar.

   - In the command prompt area, the message "*mid to*" is displayed. AutoCAD now expects us to select an existing arc or line on the screen.

14. Select the arc to move the line to the midpoint of the arc. Note that the midpoint of an arc or a line is displayed when the cursor is on top of the object.

15. On your own, repeat the above process and move the perpendicular line to the midpoint of line **AB**.

   - The constructed bisecting line is perpendicular to line **AB** and passes through the midpoint of the line or arc **AB**.
• **Bisection of an Angle**

1. Create an arbitrary angle ABC as shown in the figure.

2. Click once with the left-mouse-button on the small triangle in the titlebar of the Draw toolbar as shown.

3. Select the Construction Line icon in the Draw toolbar. In the command prompt area, the message "\_xline Specify a point or [Hor/Ver/Ang/Bisect/Offset]:" is displayed.

   Construction lines are lines that extend to infinity. Construction lines are usually used as references for creating other objects.

4. Inside the Drawing Area, right-mouse-click once to bring up the option menu.

5. Select Bisect from the option list as shown. In the command prompt area, the message "Specify angle vertex point:" is displayed.

6. Pick Snap to Endpoint in the Object Snap toolbar.
7. Select the vertex point of the angle as shown. In the command prompt area, the message “Specify angle start point:” is displayed.

8. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

9. Select one of the endpoints of the angle.

10. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

11. Select the other endpoint of the angle.

➢ Note that the constructed bisection line divides the angle into two equal parts.
Transfer of an Angle

1. Create an arbitrary angle ABC and a separate line XY as shown in the figure.

> CAD systems provide several options to allow the user to accurately measure constructed objects over the classical board drafting technique (See page 3-14). For this example, we will use the QuickCalc option to transfer the angle.

2. Select Copy in the Modify toolbar as shown.

3. Select line XY as the object to be copied.

4. Right-mouse-click once to proceed with the Copy command.

5. Pick Snap to Endpoint in the Object Snap toolbar.

6. Select point X as the base point.

7. Use the Snap to Endpoint option and select point X again to place another line on top of line XY.

8. Hit the ENTER key once to end the Copy command.

9. Select Rotate in the Draw toolbar as shown.

10. Select one of the two lines at XY.

11. Right-mouse-click once to proceed with the Rotate command.
12. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

13. Select point X as the base point for the rotation.

14. Inside the Drawing Area, **right-mouse-click** once to bring up the option menu.

15. Select **QuickCalc** in the option menu as shown.

16. Select **Angle of Line Defined by Two Points** as shown.

- Note the **Distance** option is also available in the toolbar region.

17. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

18. Select the vertex, point B, of the angle ABC as shown.

19. Pick **Snap to Endpoint** in the *Object Snap* toolbar.

20. Select point A as the second point to measure the angle as shown.

➢ The default system for measuring angles in AutoCAD 2015 defines positive angular values as counterclockwise from the positive X-axis.
21. Enter a **minus sign** behind the displayed angle in the *QuickCalc* window.

> Note the display of Active Command: Rotate in the *QuickCalc* window.

22. Select the **Angle of Line Defined by Two Points** option as shown.

23. Repeat the above process and measure the angle formed by line BC and the positive X-axis.

24. Press the **ENTER** key once to calculate the difference between the two values, which is the angle formed by line AB and line BC.

25. Enter a **minus sign** in front of the calculated value in the *QuickCalc* window as shown.

> The minus sign is used to create the new line in the clockwise direction. (We will rotate the line in a clockwise direction relative to the current XY line.)

26. Click **Apply** to transfer the calculated value to the command prompt area.

> The calculated value is now transferred in the command prompt area.
27. Press the **ENTER** key once to accept the displayed value and complete the **Rotate** command.

> You are also encouraged to perform this geometric construction using the classical method as described below. (Note that R is an arbitrary distance.)
- **Dividing a Given Line into a Number of Equal Parts**

1. Create a line \( AB \) at an arbitrary angle; the line is to be divided into five equal parts.

2. From the *Draw* toolbar, select:

   ![Divide](image)

   **[Divide]**

3. Select line \( AB \). In the message area, the message "Enter the number of segments or [Block]:" is displayed.

4. Enter 5 as the number of segments needed.

5. On your own, create an arbitrary short line segment at point \( A \).

6. Select **Copy** in the *Modify* toolbar as shown.

7. Select the **short line** as the object to be copied.

8. **Right-mouse-click** once to proceed with the Copy command.
9. Pick Snap to Endpoint in the Object Snap toolbar.

10. Select point A as the base reference point.

11. Pick Snap to Node in the Object Snap toolbar.

12. Move the cursor along line AB, and select the next node point as shown.

13. Repeat the above steps and create 3 additional lines at the nodes indicating the division of the line into five equal parts.

> We can also change the display of the created Points.

14. In the Menu Bar, select:

   [Format] ➔ [Point Style]

15. In the Point Style window, choose the 4th icon in the second row, as shown.

16. Click OK to accept the selection and adjust the point style.
**Circle through Three Points**

1. Create two arbitrary line segments, \(\text{AB} \) and \(\text{BC} \), as shown.

2. Select the 3-Point Circle command in the Draw toolbar as shown.

3. Pick Snap to Endpoint in the Object Snap toolbar.

4. Select the first point, point A.

5. Repeat the above steps and select points B and C to create the circle that passes through all three points.
• Line Tangent to a Circle from a Given Point

1. Create a circle and a point A. (Use the Point command to create point A.)

2. Select the Line command icon in the Draw toolbar. In the command prompt area, near the bottom of the AutoCAD drawing screen, the message "_line Specify first point:" is displayed. AutoCAD expects us to identify the starting location of a straight line.

3. Pick Snap to Node in the Object Snap toolbar.

4. Select point A as the starting point of the new line.

5. Pick Snap to Tangent in the Object Snap toolbar.

6. Move the cursor on top of the circle and notice the Tangent symbol is displayed.

➢ Note that we can create two tangent lines, one to the top and one to the bottom of the circle, from point A.
- Circle of a Given Radius Tangent to Two Given Lines
  Option I: TTR circle

1. Create two arbitrary line segments as shown.

2. Select TTR Circle in the Draw toolbar as shown.

3. Select one of the line segments; note the tangency is deferred until all inputs are completed.

4. Select the other line segment; note the tangency is also deferred until all inputs are completed.
5. Enter 3 as the radius of the circle.

➢ The circle is constructed exactly tangent to both lines.

---

**Option II: Fillet Command**

1. Select the **Undo** icon in the **Standard** toolbar as shown. This will undo the last step, the circle.

2. Select **Fillet** in the **Modify** toolbar as shown.

3. In the command prompt area, the message "Select first object or [Undo/Polyline/Radius/Trim/Multiple]" is displayed. By default **Mode** is set to **Trim** and the current arc **Radius** is set to **0**.

---

Current settings: Mode = TRIM, Radius = 0.0000

FILLET Select first object or [Undo Polyline Radius Trim Multiple]:

Model Layout1 Layout2 24.6649, 4.0822, 0.0000 MODEL
4. Inside the Drawing Area, right-mouse-click once to bring up the option menu.

5. Select **Radius** to adjust the radius of the fillet.

6. Enter 3 as the new radius of the Fillet command.

7. Select one of the lines as the first object.

8. Select the other line as the second object.

- Note that all of the classical methods for geometric construction, such as the one shown on page 3-14, are also applicable in CAD systems.
The Gasket Design

Exploring the possibilities of a CAD system can be very exciting. For persons who have board drafting experience, the transition from the drafting board to the computer does require some adjustment. However, the essential skills required to work in front of a computer are not that much different from those needed for board drafting. In fact, many of the basic skills acquired in board drafting can also be applied to a computer system. For example, the geometric construction techniques that are typically used in board drafting can be used in AutoCAD. The main difference between using a CAD system over the traditional board drafting is the ability to create and modify geometric entities very quickly and accurately. As it was illustrated in the previous sections, a variety of object construction and editing tools, which are available in AutoCAD, are fairly easy to use. It is important to emphasize that a good understanding of the geometric construction fundamentals remains the most important part of using a CAD system. The application of the basic geometric construction techniques is one of the main tasks in using a CAD system.

In the following sections, we will continue to examine more of the geometric construction and editing tools provided by AutoCAD 2015. We will be looking at the geometric construction tools, such as Trim, Extend, Edit Polyline and Offset that are available in AutoCAD 2015.

Before continuing to the next page, on your own make a rough sketch showing the steps that can be used to create the design. Be aware that there are many different approaches to accomplishing the same task.
Drawing Units Display Setup

Before creating the first geometric entity, the value of the units within the CAD system should be determined. For example, in one drawing, a unit might equal one millimeter of the real-world object. In another drawing, a unit might equal an inch. The unit type and number of decimal places for object lengths and angles can be set through the UNITS command. These drawing unit settings control how AutoCAD interprets the coordinate and angle entries and how it displays coordinates and units in the Status Bar and in the dialog boxes.

1. In the Menu Bar select:
   [Format] \rightarrow [Units]

2. In the Drawing Units dialog box, confirm the Length Type to Decimal. This is the default measurement to English units, inches.

3. Set the Precision to two digits after the decimal point.

4. Pick OK to exit the Drawing Units dialog box.
GRID and SNAP Intervals Setup

1. In the Menu Bar, select:

   [Tools] -> [Drafting Settings]

2. In the Drafting Settings dialog box, select the Snap and Grid tab if it is not the page on top.

3. Change Grid Spacing to 1.00 for both X and Y directions.

4. Switch ON the Grid On and Snap On options as shown.

5. Pick OK to exit the Drawing Units dialog box.
6. On your own, use the **Zoom Extents** command, under the **View** pull-down menu, to reset the display.

*Notice in the **Status Bar** area, the **GRID** and **SNAP** options are pressed down indicating they are switched **ON**. Currently, the grid spacing is set to 1 inch and the snap interval is set to 0.5 inch.*

---

**Using the **LINE** Command with ORTHO option**

1. Select the **Line** command icon in the **Draw** toolbar. In the command prompt area, near the bottom of the AutoCAD drawing screen, the message **"line Specify first point:"** is displayed. AutoCAD expects us to identify the starting location of a straight line.

2. In the Drawing Area, move the cursor to **world coordinates (4,6)**. **Left-click** to position the starting point of the line at that location.

3. We will next turn **ON** the **ORTHO** option by toggling on the **ORTHO** button in the **Status Bar** area.

*The **ORTHO** option constrains cursor movement to the horizontal or vertical directions, relative to the current coordinate system. With the **Line** command, we are now restricted to creating only horizontal or vertical lines with the **ORTHO** option.*
4. Move the graphics cursor below the last point we selected on the screen and create a vertical line that is two units long (Y coordinate: 4.00).

5. Move the graphics cursor to the right of the last point and create a horizontal line that is one unit long (X coordinate: 5.00).

6. Move the graphics cursor below the last point and create a vertical line that is 2.5 units long (Y coordinate: 1.50).

7. Turn OFF the SNAP option in the Status Bar area.

8. Move the graphics cursor to the right of the last point and create a horizontal line that is about seven units long (near X coordinate: 12.00). As is quite common during the initial design stage, we might not always know all of the dimensions at the beginning.

9. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter with the left-mouse-button to end the Line command.

10. In the Status Bar area, reset the option buttons so that only the GRID DISPLAY, and ORTHO MODE options are switched ON.

11. Activate the Line command by picking the icon in the Draw toolbar or right-mouse-click to activate the option menu and select Repeat Line.
Object Snap Toolbar

- **Object Snap** is an extremely powerful construction tool available on most CAD systems. During an entity's creation operations, we can snap the cursor to points on objects such as endpoints, midpoints, centers, and intersections. For example, we can quickly draw a line to the center of a circle, the midpoint of a line segment, or the intersection of two lines.

1. Bring up the *Object Snap* toolbar through the *Tools* ➔ *Toolbars* menu.

2. In the *Object Snap* toolbar, pick **Snap to Endpoint**. In the command prompt area, the message "_endp of" is displayed. AutoCAD now expects us to select a geometric entity on the screen.

- The *Snap to Endpoint* option allows us to snap to the closest endpoint of objects such as lines or arcs. AutoCAD uses the midpoint of the entity to determine which end to snap to.

3. Pick the **top left vertical line** by selecting a location above the midpoint of the line. Notice AutoCAD automatically snaps to the top endpoint of the line.

4. Move the graphics cursor to the right of the last point and create a horizontal line that is about **three units** long (near X coordinate: 7.00).

5. Inside the Drawing Area, **right-mouse-click** to activate the option menu and select **Enter** with the left-mouse-button to end the Line command.

6. Select the **Circle-Radius** command icon in the *Draw* toolbar. In the command prompt area, the message "Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:" is displayed.

7. In the *Status Bar* area, switch **ON** the SNAP option.
8. In the *Drawing Area*, move the cursor to world coordinates \((11.5, 6)\). **Left-click** to position the center point of the circle at this location.

9. Move the graphics cursor to world coordinates \((13, 6)\). **Left-click** at this location to create a circle (radius \(1.5\) inches).

10. Select the **Line** command icon in the *Draw* toolbar. In the command prompt area, the message "\_line Specify first point:" is displayed.

11. In the *Drawing Area*, move the cursor to world coordinates \((11, 1.5)\). **Left-click** to position the first point of a line at this location.

12. Pick **Snap to Tangent** in the *Object Snap* toolbar. In the command prompt area, the message "\_tan to" is displayed. AutoCAD now expects us to select a circle or an arc on the screen.

> The **Snap to Tangent** option allows us to snap to the point on a circle or arc that, when connected to the last point, forms a line tangent to that object.
13. Pick a location on the right side of the circle and create the line tangent to the circle. Note that the Object Snap options take precedence over the ORTHO option.

14. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter with the left-mouse-button to end the Line command.

15. In the Status Bar area, reset the option buttons so that none of the buttons are switched ON.

16. Close the Object Snap toolbar by left-clicking the upper right corner X icon.
Using the *EXTEND* Command

- The Extend command lengthens an object so that it ends precisely at a selected boundary.

1. Select the **Extend** command icon in the *Modify* toolbar. In the command prompt area, the message “Select boundary edges... Select objects:” is displayed.

   - First, we will select the objects that define the boundary edges to which we want to extend the object.

2. Pick the **circle** as the **boundary edge**.

3. Inside the *Drawing Area*, **right-mouse-click** to proceed with the **Extend** command.

4. The message “Select object to extend or shift-select object to trim or [Project/Edge/Undo]:” is displayed in the command prompt area. Extend the **horizontal line** that is to the left side of the circle by clicking near the right endpoint of the line.

5. Inside the Drawing Area, **right-mouse-click** to activate the option menu and select **Enter** with the left-mouse-button to end the **Extend** command.
Using the TRIM Command

- The Trim command shortens an object so that it ends precisely at a selected boundary.

1. Select the Trim command icon in the Modify toolbar. In the command prompt area, the message "Select boundary edges... Select objects:" is displayed.
   - First, we will select the objects that define the boundary edges to which we want to trim the object.

2. Pick the inclined line and the top horizontal line as the boundary edges.

3. Inside the Drawing Area, right-mouse-click to proceed with the Trim command.

4. The message "Select object to trim or shift-select object to extend or [Fence/Crossing/Project/Edge/eRase/Undo]:" is displayed in the command prompt area. Pick the right endpoint of the bottom horizontal line.

5. Pick the bottom of the circle by clicking on the lower portion of the circle.

6. Inside the Drawing Area, right-mouse-click to activate the option menu and select Enter with the left-mouse-button to end the Trim command.

- Note that in AutoCAD 2015, we can use the Extend command or the Trim command for trimming or extending an object. For example, when using the Extend command, we can select an object to extend or hold down SHIFT and select an object to trim.
Creating a TTR CIRCLE

1. In the Draw toolbar, click the triangle next to the Circle icon to show the additional options.

2. In the displayed list, select the Ttr (Tan, Tan, Radius) option. This option allows us to create a circle that is tangent to two objects.

3. Pick the top horizontal line that is to the left side of the arc. We will create a circle that is tangent to this line and the circle.

4. Pick the arc by selecting a location that is above the right endpoint of the horizontal line. AutoCAD interprets the location we selected as being near the tangency.

5. In the command prompt area, the message “Specify radius of circle <1.50>” is displayed.
   Specify radius of circle <1.50>: 1.0 [ENTER]

   On your own, use the Trim command and trim the circle, the horizontal line, and the arc as shown.
Using the *FILLET* Command

- Fillet rounds or fillets the edges of two arcs, circles, elliptical arcs, or lines with an arc of a specified radius.

1. Select the *Fillet* command icon in the *Modify* toolbar. In the command prompt area, the message "Select first object or [Polyline/Radius/Trim]:" is displayed.

2. Inside the Drawing Area, right-mouse-click to activate the option menu and select the **Radius** option with the left-mouse-button to specify the radius of the fillet.

3. In the command prompt area, the message "Specify fillet radius:" is displayed.

   *Specify fillet radius: 0.75 [ENTER]*

4. Pick the **bottom horizontal line** and the **adjacent vertical line** to create a rounded corner as shown.

   ➢ On your own, use the *Fillet* command and create a radius **0.25** fillet at the corner as shown.
Converting Objects into a Polyline

- The next task in our project is to use the Offset command and create a scaled copy of the constructed geometry. Prior to using the Offset command, we will simplify the procedure by converting all objects into a compound object — a polyline.

- A polyline in AutoCAD is a 2D line of adjustable width composed of line and arc segments. A polyline is treated as a single object with definable options.

1. In the Ribbon Toolbars, select:
   
   **[Modify] → [Edit Polyline]**

2. The message "Select polyline:" is displayed in the command prompt area. Select any of the objects on the screen.

3. The message “Object selected is not a polyline, Do you want to turn it into one? <Y>” is displayed in the command prompt area. **Right-mouse-click** to accept the **Yes** default.

4. Inside the **Drawing Area**, **right-mouse-click** once to activate the option menu and select the **Join** option with the left-mouse-button to add objects to the polyline.

5. **Pick all objects** by enclosing them inside a **selection window**.

6. Inside the **Drawing Area**, **right-mouse-click** once to accept the selected objects.

7. Inside the **Drawing Area**, **right-mouse-click** once to activate the option menu and select **Enter** to end the Edit Polyline command.
Using the **OFFSET** Command

- The Offset command creates a new object at a specified distance from an existing object or through a specified point.

1. Select the **Offset** command icon in the **Modify** toolbar. In the command prompt area, the message "Specify offset distance or [Through]:" is displayed.

   \[ \text{Specify offset distance or [Through]}: 0.5 \text{ [ENTER]} \]

2. In the command prompt area, the message “Select object to offset or <exit>:” is displayed. Select any segment of the polyline on the screen.

   ➢ Since all the lines and arcs have been converted into a single object, all segments are now selected.

3. AutoCAD next asks us to identify the direction of the offset. Pick a location that is *inside* the polyline.

4. Inside the **Drawing Area**, right-mouse-click and select **Enter** to end the Offset command.
Using the Area Inquiry Tool to Measure Area and Perimeter

- AutoCAD also provides several tools that will allow us to measure distance, area, perimeter, and even mass properties. With the use of polylines, measurements of areas and perimeters can be done very quickly.

1. In the Ribbon tabs area, left-mouse-click once on the Measure title in the Utilities toolbar as shown.

2. In the Inquiry toolbar, click on the Area icon to activate the Calculates the area and perimeter of selected objects command.

   - Note the different Measure options that are available in the list.

3. In the command prompt area, the message “Specify first corner point or [Object/Add/Subtract]:” is displayed. By default, AutoCAD expects us to select points that will form a polygon. The area and perimeter of the polygon will then be calculated.

4. AutoCAD can also calculate the area and perimeter of objects that define closed regions. For example, a circle or a rectangle can be selected as both of these objects define closed regions. We can also select a region defined by a polyline. To activate this option, right-mouse-click once inside the Drawing Area and select Object as shown.

5. In the command prompt area, the message “Select objects:” is displayed. Pick the inside polyline and the associated area and perimeter information are shown in the prompt area.
6. Inside the **Drawing Area**, right-mouse-click once to bring up the option menu and select **Area** as shown.

7. We can also select a region defined by multiple **polylines**. To activate this option, **right-mouse-click** once inside the Drawing Area and select **Add area** as shown.

8. To also activate selection of regions **defined** by polylines, **right-mouse-click** once inside the Drawing Area and select **Object** as shown.

9. In the command prompt area, the message **"[Add Mode] Select objects:"** is displayed. Pick the outside polyline. The associated area and perimeter information are shown in the prompt area. Right-click once to end the selection.

10. Next we will subtract the region defined by the inside polyline. In the command prompt area, select **Subtract area** as shown.

11. To also activate selection of regions defined by polylines, select **Object** in the command prompt area as shown.

12. In the **command prompt area**, the message **"Select objects:"** is displayed. Pick the **inside polyline** and the area between the two polylines is shown in the **command prompt area**.
Using the **EXPLODE** Command

- The *Explode* command breaks a compound object into its component objects.

1. Select the *Explode* command icon in the *Modify* toolbar. In the command prompt area, the message "Select objects:" is displayed.

2. Pick the *inside polyline* that we created using the *Offset* command.

3. Inside the Drawing Area, **right-mouse-click** to end the *Explode* command.

Create another **Fillet**

1. Select the *Fillet* command icon in the *Modify* toolbar. In the command prompt area, the message "Select first object or [Polyline/Radius/Trim]:" is displayed.

2. On your own, set the *Fillet Radius* to **0.5**.
   
   Specify fillet radius: **0.5** [ENTER]

3. Pick the *horizontal line* and the *adjacent inclined line* to create a rounded corner as shown.
Saving the CAD File

1. In the pull-down menus, select:

   [File] → [Save As]

2. In the Save Drawing As dialog box, select the folder in which you want to store the CAD file and enter Gasket in the File name box.

3. Pick Save in the Save Drawing As dialog box to accept the selections and save the file.

Exit AutoCAD

- To exit AutoCAD 2015, select Exit AutoCAD from the Application Menu or type QUIT at the command prompt.
Review Questions: (Time: 20 minutes)

1. Describe when and why you would use the AutoCAD ORTHO option.

2. What is the difference between a line and a polyline in AutoCAD?

3. Which AutoCAD command can we use to break a compound object, such as a polyline, into its component objects?

4. Which AutoCAD command can we use to quickly calculate the area and perimeter of a closed region defined by a polyline?

5. Describe the procedure to calculate the area and perimeter of a closed region defined by a polyline?

6. What does the Offset command allow us to do?

7. Create the following triangle and measure the area and perimeter of the triangle.

8. Create the following triangle and measure the area and perimeter of the triangle. Also find the angle Θ.
Exercises:
(Unless otherwise specified, dimensions are in inches.) (Time: 90 minutes)

1. Lines & Squares Pattern

2. Interlacement Design
3. **Positioning Spacer** (Dimensions are in inches.)

![Positioning Spacer Diagram]

4. **Indexing Base** (Dimensions are in inches.)

![Indexing Base Diagram]
5. Guide Block (Create the front view of the design. Dimensions are in inches.)
Notes: